
Uvod u informacioni i finansijski inženjering

Vežbe 5 – Excel - vizuelizacija i pivot tabele
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Formule, izrazi i funkcije
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Formule, izrazi i funkcije

● Svaka formula u Excelu uvek počinje znakom jednakosti “=”
● formula je kombinacija konstanti, promenljivih, operatora i funkcija, koja daje neki rezultat
● prilikom nekog obračuna, vrednosti koje nisu konstante i mogu biti promenjene u nekom trenutku, ne treba upisivati u formulu u 

apsolutnom iznosu

● Funkcija ima predefinisanu formulu koja izračunava određenu matematičku operaciju
● unos funkcije u polju za formule je sličan unosu formule, ali zahteva poznavanje funkcije koja se koristi, broj i redosled 

argumenata funkcije koje je potrebno uneti
● svaka funkcija počinje znakom jednako (=), potom sledi ime funkcije, koje prati otvorena zagrada, argumenti funkcije odvojeni 

tačka‐zarezima (;) i na kraju zatvorena zagrada
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Formule, izrazi i funkcije
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● argumenti mogu biti brojevi, tekst, logičke vrednosti, 
adrese ćelija, opsezi ćelija, konstante, formule ili druge 
funkcije

● opseg ćelija se unosi adresom početne i poslednje ćelije 
u nizu, razdvojene sa dvotačkom (npr. A1:C1 – obuhvata 
ćelije A1, B1 i C1)

● U Excelu postoji i lakši način za odabir funkcije i unos svih 
njenih argumenata

○ klikom na dugme fx u polju za formule, pojaviće se prozor 
za odabir željene funkcije



Formule, izrazi i funkcije

● U prozoru prikazanom na prethodnom slajdu postoji nekoliko načina da se pronađe potrebna funkciju:
○ Search for a function - služi za pronalaženje funkcije unosom njenog kratkog opisa
○ Or select for a category - u ovoj padajućoj listi funkcije su razvrstane po kategorijama kojoj pripadaju, izborom kategorije, u donjem delu 

prozora prikazuju se samo funkcije koje joj pripadaju, čime se olakšava pretraga
○ Select a function - u ovoj listi bira se potrebna funkciju, a nakon potvrde, pojavljuje se prozor izabrane funkcije za poljima za unos 

potrebnih argumenata
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Formule, izrazi i funkcije

● Funkcija COUNT
■ vrši prebrojavanje broja ćelija u određenom opsegu 

COUNT(range)

● Funkcija SUM
○ vrši sabiranje vrednosti u određenom opsegu 

SUM(range)

● Funkcija AVERAGE
○ vrši izračunavanje prosečne vrednosti u određenom opsegu

AVERAGE(range)

● Funkcija MAX i MIN
○ koriste se za računanje maksimuma (MAX), odnosno minimuma (MIN) u određenom opsegu

MIN(range)

MAX(range)
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Formule, izrazi i funkcije

● Funkcija IF
○ pruža mogućnost pravljenje logičkih poređenja između stvarnih i očekivanih vrednosti

IF(logical_test;value_if_true;value_if_false)

● Funkcija COUNTIF
○ vrši prebrojavanje broja ćelija u određenom opsegu, koje zadovoljavaju postavljeni uslov

COUNTIF(range;criteria)

● Funkcija SUMIF
○ vrši sabiranje vrednosti u određenom opsegu koje zadovoljavaju postavljeni uslov

SUMIF(range;criteria;sum_range)

● Funkcija MAXIF i MINIF
○ ne postoje,  moraju se kombinovati funkcije MAX i MIN sa funkcijom IF (nakon unosa formule treba pritisnuti Ctrl+Shift+Enter)

MIN(IF(logical_test;range))

MAX(IF(logical_test;range))
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Formule, izrazi i funkcije

● Funkcija INT
○ vrši zaokruživanje naniže, ka najbližem celom broju 

INT(range)

● Funkcija ROUND
○ vrši zaokruživanje na željeni broj decimala
○ postoje još dve funkcije slične funkciji ROUND, imaju istu sintaksu, a razlikuju se u tome što ROUNDUP vrši zaokruživanje na prvi veći 

broj, za zadati broj decimala, a ROUNDDOWN na prvi manji broj

ROUND(range;num_digits)

● Funkcija CEILING
○ vrši zaokruživanje ka višem broju u odnosu na faktor zaokruživanja

CEILING(range;[significance])

● Funkcija FLOOR
○ vrši zaokruživanje ka nižem broju u odnosu na faktor zaokruživanja

FLOOR(range;[significance])
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Formule, izrazi i funkcije
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BROJ INT ROUND CEILING FLOOR ROUNDUP ROUNDDOWN

4,51 4 5 5 4 5 4

3,6 3 4 4 3 4 3

4,6 4 5 5 4 5 4

2,15 2 2 3 2 3 2

4,05 4 4 5 4 5 4

1,56 1 2 2 1 2 1

2,93 2 3 3 2 3 2

4,76 4 5 5 4 5 4

2,45 2 2 3 2 3 2

1,35 1 1 2 1 2 1



Formule, izrazi i funkcije

● Funkcija POWER
○ dobijanje stepena određenog broja

POWER(number;power)

● Funkcija SQRT
○ dobijanje kvadratnog korena određenog broja

SQRT(number)

● Funkcija ABS
○ dobijanje apsolutne vrednosti broja

ABS(number)

● Funkcija PI
○ dobijanje vrednosti broja PI

PI()
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Formule, izrazi i funkcije

● Funkcija LEFT
○ izdvajanje prvih nekoliko znakova iz teksta

LEFT(text;num_chars)

● Funkcija RIGHT
○ izdvajanje poslednjih nekoliko znakova iz teksta

RIGHT(text;num_chars)

● Funkcija MID
○ izdvajanje određenog broja znakova iz teksta, počevši od određene pozicije

MID(text;start_num;num_chars)

● Funkcija FIND i SEARCH
○ pronalaženje pozicije od koje počinje neki string unutar zadatog teksta (FIND pravi razliku između velikih i malih slova)

FIND(find_text; within_text;start_chars)

SEARCH(find_text; within_text;start_chars)
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Formule, izrazi i funkcije

● Funkcija UPPER
○ pretvaranje teksta u velika slova

 UPPER(text)

● Funkcija LOWER
○ pretvaranje teksta u mala slova

LOWER(text)

● Funkcija PROPER
○ pretvaranje početnih slova u rečima u velika, a sva ostala u mala

PROPER(text)

● Funkcija TRIM
○ uklanjanje viška razmaka iz teksta

TRIM(text)

● Karakter „*“ menja proizvoljan broj znaka (npr. naći koliko ima ljudi čije ime počinje na A)
● Karakter „?“ menja jedan znak (npr. naći koliko ima ljudi čije ime na drugom mestu sadrži a)
● Pogledati još i funkcije CONCATENATE, LEN 13



Formule, izrazi i funkcije

● Ukoliko se prilikom unosa formula pojave rezultati koji počinju sa „#“ to znači da formula daje pogrešan rezultat
● Vrste poruka o grešakama:

○ ###### - širina ćelije nije dovoljna da se prikaže ceo rezultat (samo je potrebno proširiti ćeliju),
○ #DIV/0! - pokušaj deljenja s nulom ili praznom ćelijom,
○ #NAME! - Excel ne prepoznaje ime funkcije koje se u formuli koristi (dešava se kada se izbriše ime upotrebljeno u formuli ili se ne unese 

pravilno),
○ #N/A - podatak ćelije nije na raspolaganju,
○ #NULL! - formula koristi presek dva područja koja se ne seku (preseci područja se odnose na ćelije koje su zajedničke za dva područja, 

npr. A1:A6 i B3:E3),
○ #NUM! - postoji problem s vrednošću (unet je negativan broj gde se traži pozitivan),
○  #REF! - u formulu je uneta neispravna referenca, koja se poziva na neispravnu adresu ćelije (npr. ukoliko je ćelija izbrisana s radnog 

lista) i
○ #VALUE! - formula sadrži argument ili operand pogrešnog tipa
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Zadatak 1

● Na fakultetu iz jednog predmeta studenti treba da skupe barem 25 bodova od 50 da bi prošli neki ispit.  Odredite ko od 
studenata je prošao ispit, a ko nije. Potrebno je i izračunati koliko je studenata položilo, a koliko palo predmet.
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Zadatak 1 - Rešenje

● Na fakultetu iz jednog predmeta studenti treba da skupe barem 25 od 50 bodova da bi prošli neki ispit.  Odredite ko od 
studenata je prošao ispit, a ko nije. Potrebno je i izračunati koliko je studenata položilo, a koliko palo predmet.
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=IF(D3>=25,"PROSAO","NIJE PROSAO")

=COUNTIF(E3:E13,"PROSAO")

=COUNTIF(E3:E13,"NIJE PROSAO")



Zadatak 2

● Ako učenik ima jedinica, u polju prosečna ocena treba da stoji 1, u protivnom vrednost prosečne ocene
● Ako učenik ima jedinica, u polju opomene treba da piše DA, u protivnom NE
● Učenika (tj. polje broj opomena) koji ima više od dve 1 označiti crvenom bojom - koristiti Conditional Formatting.
● U polju Zaključak treba da piše PRIMERAN, ako učenik ima manje od 5 neopravdanih izostanaka, u suprotnom IMA 

IZOSTANAKA.
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Zadatak 2 - Rešenje

● Ako učenik ima jedinica, u polju prosečna ocena treba da stoji 1, u protivnom vrednost prosečne ocene
● Ako učenik ima jedinica, u polju opomene treba da piše DA, u protivnom NE
● Učenika (tj. polje broj opomena) koji ima više od dve 1 označiti crvenom bojom - koristiti Conditional Formatting.
● U polju Zaključak treba da piše PRIMERAN, ako učenik ima manje od 5 neopravdanih izostanaka, u suprotnom IMA 

IZOSTANAKA.
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=COUNTIF(D4:F10,5)

=SUMIF(J4:J10,"DA",M4:M10)



Zadatak 2 - Rešenje

● Ako učenik ima jedinica, u polju prosečna ocena treba da stoji 1, u protivnom vrednost prosečne ocene
● Ako učenik ima jedinica, u polju opomene treba da piše DA, u protivnom NE
● Učenika (tj. polje broj opomena) koji ima više od dve 1 označiti crvenom bojom - koristiti Conditional Formatting.
● U polju Zaključak treba da piše PRIMERAN, ako učenik ima manje od 5 neopravdanih izostanaka, u suprotnom IMA 

IZOSTANAKA.
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=IF(J4="NE",AVERAGE(D4:G4),1)

=COUNTIF(D4:G4,1)

=IF(I4=0,"NE","DA")



Zadatak 2 - Rešenje

● Ako učenik ima jedinica, u polju prosečna ocena treba da stoji 1, u protivnom vrednost prosečne ocene
● Ako učenik ima jedinica, u polju opomene treba da piše DA, u protivnom NE
● Učenika (tj. polje broj opomena) koji ima više od dve 1 označiti crvenom bojom - koristiti Conditional Formatting.
● U polju Zaključak treba da piše PRIMERAN, ako učenik ima manje od 5 neopravdanih izostanaka, u suprotnom IMA 

IZOSTANAKA.
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=SUM(K4:L4)

=IF(M4<5,"PRIMEREN","IMA IZOSTANAKA")



Zadatak 3
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Zadatak 3 - Rešenje
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=SUM(C3:F3)

=MIN(E3:E14)
=MAX(D3:D14)
=AVERAGE(C10:F10)



Zadatak 6
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Zadatak 6 - Rešenje
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Zadatak Formula

Broj osoba iz Beograda: =COUNTIF(F3:F16,"Beograd")

Broj osoba iz Novog Sada: =COUNTIF(F3:F16,"Novi Sad")

Broj osoba s imenom "Boško": =COUNTIF(C3:C16,"Boško")

Broj osoba s prezimenom "Mandić": =COUNTIF(D3:D16,"Mandić")

Broj osoba kojima prezime počinje sa slovom "K": =COUNTIF(prz,"K*")

Broj osoba kojima ime počinje sa slovom "A": =COUNTIF(ime,"A*")

Broj osoba kojima se prezime završava slovom "ć": =COUNTIF(prz,"*ć")

Broj osoba kojima se ime završava slovom "n": =COUNTIF(ime,"*n")

Broj osoba kojima je drugo slovo u prezimenu "o": =COUNTIF(prz,"?o*")

Suma plata svih radnika Frikoma: =SUMIF(pred,"Frikom",plt)

Suma plata svih radnika Galenika: =SUMIF(pred,"Galenika",plt)

Suma plata svih žena: =SUMIF(pol,"Ž",plt)

Dodeljen naziv "prz" opsegu od D3:D16

Dodeljen naziv "ime" opsegu od C3:C16

Dodeljen naziv "plt" opsegu od I3:I16 i 
"pred" opsegu H3:H16

Dodeljen naziv "pol" opsegu od E3:E16



Zadatak 6 - Rešenje
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Suma plata svih sa prihodom većim od 65.000 =SUMIF(plt,">65000",plt)

Prosek godina svih muškaraca =AVERAGEIF(pol,"M",god)

Suma godina svih radnika Hemofarma =SUMIF(pred,"Hemofarm",god)

Suma plata svih muškaraca =SUMIF(pol,"M",plt)

Prosek godina svih žena =AVERAGEIF(pol,"Ž",god)

Suma plata svih radnika kojima ime počinje sa slovom "B" =SUMIF(ime,"B*",plt)

Ukupan broj svih radnika =COUNT(B3:B16)

Prosečna plata svih radnika =AVERAGE(plt)

Prosečna plata svih žena =AVERAGEIF(pol,"Ž",plt)

Prosečna plata svih muškaraca =AVERAGEIF(pol,"M",plt)

Najveća plata =MAX(plt)

Najmanja plata =MIN(plt)

Najveća plata radnika Galenike =MAX(IF(pred="Galenika";plt))

Najmanja plata radnika Galenike =MIN(IF(pred="Galenika";plt))

Dodeljen naziv "god" opsegu od G3:G16



Provera valjanosti podataka
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Provera valjanosti podataka
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● Data → Data Validation
○ postavljanje ograničenja u vezi sa podacima koji mogu ili treba da budu uneti u ćeliju
○ doprinosi smanjivanju grešaka prilikom ručnog unosa
○ mogu da se definišu upozorenja u slučaju unosa pogrešnih rezultata, kao i uputstva o ograničenjima

● Tipovi ograničenja:
○ ograničenje podataka u unapred definisanim stavkama na listi 
○ ograničenje brojeva u određenom opsegu
○ ograničenje datuma u određenom vremenskom okviru
○ ograničenje vremena izvan određenog vremenskog okvira
○ ograničenje broja tekstualnih znakova itd.



Provera valjanosti podataka
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● Postoje tri tipa upozorenja:
○ Stop - sprečava korisnika da unese pogrešne podatke u ćeliju

○ Warning - upozorava korisnika da su uneti podaci pogrešni, bez sprečavanja unosa tih 
podataka

○ Information - obaveštava korisnika da su podaci koje su uneti nevažeći bez sprečavanja 
unosa tih podataka (ovaj tip upozorenja o grešci je najfleksibilniji)



Zadatak 9

● Uneti i izračunati nedostajuće podatke. Postaviti ograničenje da u kolonu PLT ne sme biti uneta vrednost manja od 50000, kao i 
da u kolonu RUK ne sme biti uneta vrednost koja ne postoji u MBR-u. 
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Zadatak 9 - Rešenje
● Uneti i izračunati nedostajuće podatke. Postaviti ograničenje da u kolonu PLT ne sme biti uneta vrednost manja od 50000, kao i 

da u kolonu RUK ne sme vrednost koja ne postoji u MBR-u. 
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Zadatak 9 - Rešenje

● Uneti i izračunati nedostajuće podatke. Postaviti ograničenje da u kolonu PLT ne sme biti uneta vrednost manja od 50000, kao i 
da u kolonu RUK ne sme vrednost koja ne postoji u MBR-u. 
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=12*E6

=SUM(E6:E13) =SUM(F6:F13)



Zadatak 9 - Rešenje

● Uneti i izračunati nedostajuće podatke. Postaviti ograničenje da u kolonu PLT ne sme biti uneta vrednost manja od 50000, kao i 
da u kolonu RUK ne sme vrednost koja ne postoji u MBR-u. 
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Zadatak 10

● Dodati kolonu "Ime i prezime" koja predstavlja spojene vrednosti kolone IME i kolone PRZ.
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Zadatak 10 - Rešenje

● Dodati kolonu "Ime i prezime" koja predstavlja spojene vrednosti kolone IME i kolone PRZ.
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=CONCATENATE(C4," ",D4)



Grafikoni
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Grafikoni
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● Grafikoni (engl. charts) - pružaju mogućnost grafičkog prikaza podataka
○ pružaju jednostavan i jasan način prikaza pregleda nad promenama u podacima, njihovo međusobno upoređivanje i olakšavaju 

razumevanje mogućih uzroka koji dovode do tih promena
○ pomažu da se iz mnoštva numeričkih podataka dobiju korisne i upotrebljive informacije

● Grafikon je objekat koji Excel pravi u skladu sa zahtevima korisnika
○ povezan sa podacima na osnovu kojih je generisan i svaka promena podataka na radnom listu, odražava se i na grafikon

● Excel poseduje mnogo različitih vrsta grafikona



Grafikoni
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● Vrste grafikona:
○ Stubičasti grafikon (engl. Column chart)
○ Linijski grafikon (engl. Line chart)
○ Kružni grafikon (engl. Pie chart)
○ Trakasti grafikon (engl. Bar chart)
○ Oblasni grafikon (engl. Area chart)
○ XY grafikon
○ mnogi drugi



Grafikoni
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● Za kreiranje grafikona koriste se podaci koji se nalaze u ćelijama radnog lista
● Postupak pravljenja jednog grafikona sastoji se iz sledećih koraka*:

○ izbor vrste grafikona
○ unos podataka koji se prikazuju
○ podešavanje izgleda grafikona i
○ promena lokacije grafikona

● Izbor vrste grafikona se vrši na kartici Insert, u odeljku Charts
● Unos podataka podrazumeva izbor niza ćelija u koloni ili redu koji se želi prikazati na grafikonu

○ nakon izbora vrste grafikona, unos podataka se obavlja preko kontekstne kartice Design, odeljak Data, opcija Select Data

*Mogu se prvo odabrati podaci, pa onda birati vrsta grafikona



Grafikoni
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● Podešavanje izgleda grafikona podrazumeva dodelu naziva grafikonu, naziva osa, 
podešavanje legende, aktiviranje prikaza podataka iz tabele 

● na kartici Design, odeljak Chart Layouts nalaze se alati za navedene operacije, na 
Add Chart Element
○ Chart Title – podešavanje naziva grafikona
○ Axis Titles – podešavanje naziva osa
○ Data Labels - dodela oznake podacima
○ Legend - prikazivanje ili skrivanje legende sa imenima serija podataka koji su prikazani 

na grafikonu
○ Gridlines - prikazivanje ili skrivanje pomoćnih osa



Grafikoni
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● Ukoliko korisnik ne želi da dodaje prethodne elemente grafikona pojedinačno, Excel pruža predefinisane šeme grafikona
○ na kartici Design, odeljak Chart Layouts, na Quick Layout

● Excel takođe pruža mogućnost izbora različitih stilova grafikona
○ na kartici Design, odeljak Chart styles 

● Još neke od mogućnosti pri radu sa grafikonima (takođe kartica Design):
○ zamena redova i kolona (odeljak Data)
○ promena vrste grafikona (odeljak Type)
○ promena lokacije grafikona (odeljak Location)



Zadatak 4

● Kreirati stubičasti i kružni grafikon spram podataka za svaki artikal.
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Zadatak 4 - Rešenje

● Kreirati stubičasti i kružni grafikon za spram podataka za svaki artikal.
● Koraci za kreiranje stubičastog grafikona:

○ selektovati područje B3:E7 (sve osim ćelije Godišnja prodaja)
○ Insert → Charts → Column Chart (2D ili 3D)

42

Opciono → dodatna podešavanja (naslov grafikona, legenda, izgled…)



Zadatak 4 - Rešenje

● Kreirati stubičasti i kružni grafikon za spram 
podataka za svaki artikal.

● Koraci za kreiranje kružnog grafikona za keks:
○ selektovati područje B3:C7 
○ Insert → Charts → Pie Chart 
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Zadatak 4 - Rešenje

● Kreirati stubičasti i kružni grafikon za spram 
podataka za svaki artikal.

● Koraci za kreiranje kružnog grafikona za 
čokoladu/bombone:
○ selektovati područje B3:E7 (sve osim ćelije 

Godišnja prodaja)
○ Insert → Charts → Pie Chart 
○ Design → Data → Select Data
○ Legend Entries (Series)

■ selektovati ili čokoladu ili bombone
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Opciono → dodatna podešavanja (naslov grafikona, legenda, izgled…)



Zadatak 5

● Izračunati nedostajuće vrednosti i grafički prikazati procenat uspeha učenika, pomoću kružnog grafikona.
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Zadatak 5 - Rešenje

● Izračunati nedostajuće vrednosti i grafički prikazati procenat uspeha učenika, pomoću kružnog grafikona.
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=SUM(D6:D11)

=D6/$D$3



Zadatak 5 - Rešenje

● Izračunati nedostajuće vrednosti i grafički prikazati procenat uspeha učenika, pomoću kružnog grafikona.
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Pivot tabele
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Pivot tabele

49

● Pivot tabele predstavljaju alat za kreiranje interaktivnih izveštaja koji se prave na osnovu selektovanih podataka ili tabela
○ kolone iz izvornih tabela se koriste kao dimenzije izveštavanja (vrši se zbrajanje podataka u njima) ili se koriste za analizu, kao filteri
○ napravljenjene pivot tabele se lako menjaju dodavanjem/uklanjanjem dimenzija

■ više različitih pogleda na jedinstven skup podataka

● Za kreiranje pivot tabela potrebno je imati dobro pripremljene podatke
○ moraju se nalaziti unutar struktuirane tabele ili standardne Excel tabele
○ tabela mora imati zaglavlje gde su opisani podaci u koloni (npr. IME, PRZ, PLATA itd.)

● Korišćenjem pivot tabele mogu se dobiti unakrsni i vrlo detaljni međuzbirovi
○ dobijene informacije mogu se raspoređivati na razne načine



Pivot tabele
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● Kreiranje pivot tabele počinje izborom (selektovanjem) željenih 
podataka (opseg podataka, struktuirana tabela, imenovani blok 
ćelija)

● Nakon selektovanja podataka, pivot tabela se kreira korišćenjem 
kartice Insert, opcije pivot Table (otvara se dijalog prozor Create 
PivotTable)
○ u polje Table/Range potrebno je uneti opseg ćelija početne table
○ ukoliko se koriste podaci iz spoljašnje datoteke (npr. baze podataka, 

tako što se odabere tabela ili set podataka nastao pokretanjem 
željenog SQL upita) bira se opcija Use an external data source

○ potrebno je odrediti da li se pivot tabela  kreira u novom listu ili na 
određenoj poziciji u postojećem radnom listu



Pivot tabele

● Nakon potvrde kreiranja, na odabranoj poziciji u listu pojaviće 
se objekat Pivot table, kao i kontrolni panel sa desne strane 
lista, Pivot Table Fields
○ u gornjem delu panela nalaze se polja, odnosno dimenzije 

izveštavanja, a u donjem delu, u obliku kvadrata, nalaze se četiri 
oblasti: Values, Rows,  Columns i Filters

○ selektovanjem ili prevlačenjem dimenzija u neko od ove četiri 
oblasti kreiraju se izveštaji

○ u slučaju selektovanja Excel sam zaključuje u kojoj oblasti bi 
neka dimenzija trebala da se pojavi, dok prevlačenjem korisnik 
sam bira gde će se ona nalaziti
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Pivot tabele

● U oblasti vrednosti (Values) treba da se nalaze one kolone koje 
se zbrajaju

● U redovima (Rows) ili kolonama (Columns) nalaze se one 
dimenzije po kojima se vrši zbrajanje (sumiranje, prebrojavanje 
itd.)

● Filteri (Filters) predstavljaju one dimenzije po kojima se filtriraju 
podaci u tabeli 

● U polju Values za izabrane podatke moguće je promeniti funkciju
○ selektovati podatak kojem se želi promeniti funkcija, pa izabrati 

opciju Value Field Settings
○ nakon toga u prozoru koji se pojavljuje može se izabrati i 

promeniti funkcija
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Zadatak 7

● Izračunati nedostajuće podatke. Kreirati pivot tabelu.
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Zadatak 7 - Rešenje

● Izračunati nedostajuće podatke. Kreirati pivot tabelu.

54

=SUMIF(reg,G3,prodaja) =COUNTIF(reg,G3)

*Dodeljen naziv "reg" opsegu D3:D31, naziv "mesec" opsegu C3:C31 i naziv "prodaja" opsegu E3:E31

=SUMIF(mesec,G11,prodaja) =COUNTIF(mesec,G11) =SUM(prodaja)
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Zadatak 7 - Rešenje
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Zadatak 7 - Rešenje
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Zadatak 8

● Izračunati nedostajuće vrednosti i kreirati pivot tabelu.
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Zadatak 8 - Rešenje
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=H6*I6



Kraj!
Hvala na pažnji!
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